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Abstract: In city planning managing, the third dimension is becoming a necessity. Using 3D GIS modeling offers a flexible interactive 

system while providing one of the best visual interpretations of data which supports planning and decision processes for city planners. 

As a result, 3D GIS model expresses terrain features in an intuitive way which enhances the management and analysis of a proposed 

project through 3D visualization. This paper discusses the concept of 3D GIS modeling techniques using a simple procedure to generate 

a high resolution ortho imagery model (real 3D GIS model) which will show the effectiveness of this approach. The 3D GIS model 

provides access to mapping data to support planning, design and data management. Intelligent GIS models and GIS tools help 

community planning and apply regional and discipline-specific standards. Integration of GIS spatial data with aerial image helps to 

improve quality, productivity and asset management. The following study built 3D GIS map and all utility information for high 

resolution ortho image as an example. The primary objective is to improve data management (e.g., maps, plans, usage of facilities and 

services) and to develop methods using 3D spatial analysis for specific applications at the university. In this work, we discuss the 

construction of a digital elevation model based on aerial image stereo pairs using matching method and the use of this DEM for 3D city 

planning. We used aerial photographs with high accuracy (1/4000) covering the study area acquired in 2015 and additional 

cartographic data from usgs. 3D land use zoning allowed building volumes, usage, and density. They are the main tools defining the 

image of a city and bring into focus the model of best practice of the rehabilitation and conservation of the historic Medina. 
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1. Introduction 
 
In the past, multiple software tools were required for 

viewing parcels, streets, addresses, sewers, Streetlights and 

other elements of a work site. Nowadays, the GIS 

(geographic information system) is the most active 

technology in Geographic Science and Earth Science. With 

the development of computer and network software and 

hardware, GIS allows users to visualize, analyze and manage 

spatial data that is geographically referenced . One of the 

powerful features of GIS is the ability to overlay spatial 

datasets such as infrastructure locations, street widths, 

building footprints and tree locations allowing users to 

visualize and understand the relationships between data. The 

ability of GIS to display and analyze spatial data makes it an 

effective tool for physical planning(e.g., land use, 

infrastructure and transportation planning). In many 

interactive computer graphics applications, maps in 3D 

(three dimensions) are central to enabling the exploration, 

presentation and manipulation of geographical data. 3D 

maps are used by GIS specialists as tools for presentation of 

spatial data to non-experts. Recently, the geo informatics 

systems, 3D computer graphics and 3D GIS have been 

emerged with reality. most of the 3D GIS applications tend 

to focus on visualization such as walk-through animations or 

scenic simulations. The 3D data model is regarded as a tool 

to express the 3D objects in reality. Three dimensional 

models consisting of the geometry and texture of urban 

surfaces could aid applications such as urban planning and 

heritage conservation. A standard technique used to create 

large-scale city models automatically or semi-automatically 

is to apply stereo vision on aerial or satellite imagery. 3D 

city models are digital representations of the Earth’s surface 

and related objects belonging to urban areas (like cities, 

factories, buildings etc.). Several disciplines like urban 

planning, architecture, telecommunication, tourism, 

environmental protection. 

 

The 3D city model generate from this arial image can be 

used in many applications. To visualize the city for various 

purposes (tourism, virtual tours, etc.), 

 In urban planning, 

 In navigation systems, 

 In intelligent transportation systems, 

 In urban risk modeling; 

 In architectural visualization; 

 In telecoms – positioning of mobile phone transmitters; 

 In flood risk mapping. 

 

2. Literature Review 
 

3D map is one of the main topics in the GIS(geographic 

information system).There are many research efforts in the 

area of developing 3D maps.Brooks and Whalley [3] 

presented a unique GIS that,seamlessly integrates 2D and 

3D views from the same spatial data. Multiple layers of 

information are continuously transformed between the 2D 

and 3D modes under the control of the user, directly over a 

base-terrain. Although 2D/3D hybrid or combination 

displays, is now widely used in medical applications such as 

tomography, they have not been explored to any great extent 

in GIS applications. Many existing commercial 3D GIS 

systems have 2D views they are typically isolated from the 

3D view that they are presented in a separate window. 

Brooks and Whalley [3] introduced a 2D/3D hybrid GIS that 

allows the user to view the 2D data in direct relation to the 

3Dview within the same perspective. The conclusion of this 

research has developed a unique 2D/3D hybrid GIS with 

multiple navigational tools. Swanson [5]studied and 
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addressed the 3D visualization and analysis of geographic 

data, as she stated The introduction of 3D graphics into 

architecture, engineering and molecular biology has fostered 

new expectations in those fields. There certainly appears a 

need for visualization in nearly every subfield of geography 

as well. For example, it could prove a very persuasive tool in 

the hands of city planners, urban designers and traffic 

engineers. Possibly even, they could use it to bring abstract 

project variables like visual impact analysis into the cost-

benefit equation. The potential is definitely there to do a lot 

more interesting perspective views of remotely sensed data. 

 

Shehata and Koshak [6] constructed a 3D model to 

understand and analyze the locations, types and sizes of the 

possible natural risks in Mina (near Makkah, Saudi Arabia). 

This is a city of tents that accommodates around two million 

pilgrims during the season of Hajj (Islamic pilgrimage). The 

3D GIS can be used to analyze slopes and investigate water 

drafting paths and the locations of possible falling rocks. 

The paper provides illustrations of possible areas of risk, 

using 2D and 3D visualizations and offers recommendations 

to avoid future environmental hazards. The paper also shows 

areas that are prime locations for future development and 

assesses their safety hazard. They have built a 3D GIS 

model of 

Mina [6]. 

 

Ohigash et al. [7] proposed a mechanism to migrate a 2D 

legacy system with its GUI (graphical user interface) into a 

3D environment. This mechanism isbased on a special 

coordinate transformation for both the texture mapping and 

the event dispatching. It enables them to use a 3D terrain 

model with a shadow copy of a 2D legacy GIS. As for 

legacy geographic simulators and legacy databases without 

any GUI  they provide them with their proxy objects. These 

proxy objects can interoperate with each other, and also with 

the shadow copy of a 2D legacy GIS through their slot 

connections. As a result, their approach enables them to 

dynamically integrate multiple independent legacy 

simulators and/or legacy databases with a 2D legacy GIS 

simply through the composition of their 3D display objects. 

In conclusion, they developed a framework for the ad hoc 

integration of legacy geographic simulators, legacy 

databases, the integrated visualization of their results and a 

2D legacy GIS system [7].and sharing AutoCAD Map 3D 

and Autodesk Map Guide technology drive efficiency and 

effectiveness by making it easier to work on the data within 

desktop applications and over the Web. Powered by 

FDO(feature data objects), these foundation technologies 

allow users to access data directly and seamlessly in a 

variety of formats and data storage systems, the AutoCAD 

Map 3D and Autodesk Map Guide technology illustrate how 

the AutoCAD Map 3D and Autodesk Map Kalil and 

Braswell [8], used AutoCAD Map 3D and Autodesk Map 

Guide Enterprise as their foundation technology, Autodesk 

offers a complete solution that helps organizations to realize 

efficiencies and optimize the value of geospatial data. 

AutoCAD Map 3D provides the desktop backbone that 

supports the data creation, editing and management. The 

Autodesk Map Guide Enterprise delivers powerful, easy 

touse online maps and related information for a development 

environment which then leverages the advantages of open 

source technology, including low cost of ownership and 

easier integration with diverse databases. In conclusion, 

AutoCAD Map 3D and Autodesk Map Guide Enterprise 

provide organizations with a robust foundation for all 

activities that depend on geospatial data. From data creation 

and editing to management Guide Enterprise drive the 

seamless creation, editing, management and sharing of data 

[8]. 

 

Additionally, the open geospatial viewers (e.g. Google 

Earth, Virtual Earth, etc.) increase the demand on 3D city 

models (Remondino et al., 2006). 3D building and its update 

require the development of automatic methods for 

acquisition of Digital Surface Models (DSM) (Toutin and 

Gray, 2000). Digital photogrammetry, both airborne and 

spatial, is an efficient modern technique for DSM 

acquisition as a base for 3D building. A digital surface 

model represents the elevation associated with the surface of 

the earth including topography and all natural or human-

made features located on the surface of the earth. There is a 

variety of DSM source data available for developed areas 

and the suitability of these available data depends on the 

project specifications. In remote regions around the World, 

where little or no source data are available, the DSM can be 

produced automatically from stereo satellite scenes, from 

satellite sensors such as IKONOS, SPOT-5 and Terra-

ASTER (Baltsavias and Stallmann, 1993; Gruen et al., 2007; 

Jacobsen, 2004).  

 

3. Material and Method 
 

Study Region and Used Test Data 

Bangalore, capital city of Karnataka is the sixth largest 

metropolis in the country and a nerve center for the various 

cultural, social and religious activities, contributing to the 

growth of the city.  Bangalore district is situated in the heart 

of the South-Deccan plateau in peninsular India to the 

South-Eastern corner of Karnataka State between the 

latitudinal parallels of 12o39' N & 13o18' N and longitudinal 

meridians of 77o22' E & 77o 52'E at an altitude of about 

3000ft. above sea level covering an area of 2,190 sq. kms. 

The temperature varies from a minimum of 14oC to a 

maximum of 33oC and Rainfall (Actual) of about 1060 mm. 

The pleasant weather has the warmest months from March 

to May, coldest months from December to January, rainy - 

southwest monsoon from June to September and rainy - 

northeast monsoon from November to December. 
 
Bangalore has a total of 198 wards spread across the 4 taluks 

namely, Bangalore North, Bangalore South, Bangalore East 

and Anekal. It is also categorised into zones namely, 

Byatarayanapura Zone,Dasarahalli Zone, 

Rajarajeshwarinagar Zone, South Core Zone, West Core 

Zone, East Core Zone, Bommanahalli Zone and 

Mahadevapura Zone 

 

The present study area is located in Bangalore South Taluk 

and belongs to Bommanahalli Zone 
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Geo-referencing operation concerns the sensor orientation 

that include the determination of the exterior orientation 

along the flight trajectory of each flight strip and the 

resampling of the scanner data into the object coordinate 

system.With the help of some control points the GPS/IMU-

model can be shifted and rotated for correcting the datum 

definition. This model is defined for each flight strip and 

with control and ties points and transformed into the object 

coordinate system. 

 

 
 

Geo-Referencing Images 

Before the image analysis can be performed, the camera data 

have to be geometrically rectified (Geo-referenced)with 

respect to a map projection system Geo-referencing 

operation concerns the sensor orientation that include the 

determination of the exterior orientation along the flight 
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trajectory of each flight strip and the resampling of the 

scanner data into the object coordinate system (Ecker et al., 

1993). With the help of some control points the GPS/IMU-

model can be shifted and rotated for correcting the datum 

definition. This model is defined for each flight strip and 

with control and ties points and transformed into the object 

coordinate system. 

 

Ground Point Coordinate Determination 

This method generally contains three basic steps: 

 

Set up sensor mathematical model to reflect the relationship 

between points on the ground and pixels on the image,do 

image matching to get a disparity map, and finally calculate 

each point’s altitude. In this study, we can use the procedure 

of DEM generation developed.This process can be broken 

down into the following steps: 

 

The point measurement tool is designed to collect Ground 

Control Points (GCPs) and tie points that are common to two 

images so that the images can be correlated. In the caseof 

IKONOS imagery, the RPC file that comes with the images 

contains valuable information that lessens the need to collect 

large numbers of control points. In this step we can see how 

choosing GCPs and generating automatic tie points can 

considerably improve the results of the orthorectification. 

 

Digital Image Matching for DEM 

Ground points appearing within the overlap portion of the 

left and right images associated with a DEM are 

identified.This is referred to as digital image matching. The 

resulting output consists of the image location of ground 

points appearing within a DEM. (DEM images are download 

from USGS or GLOVIS) 

 

DEM Construction with Aerial Image 

The automatically extracted and calculated mass points are 

used as a basis for constructing a DEM. DEMs are 

constructed differently depending on the specified DEM 

output type. 

 

Digital Elevation Models (DEMs) are a type of raster GIS 

layer. Raster GIS represents the world as a regular 

arrangement of locations. In a DEM, each cell has a value 

corresponding to its elevation. The fact that locations are 

arranged regularly permits the raster GIS to infer many 

interesting associations among locations: Which cells are 

upstream from other cells? Which locations are visible from 

a given point? Where are the steep slopes? One of the most 

powerful applications of DEMs is adding synthetic 

hillshading to maps so that the map reader may see the 

relationship between terrain and other things you may be 

mapping 

 

 

 
 
 

 
Explore your Elevation Raster 
 

The U.S. Geological Survey National Elevation Dataset is an 

example of a continuous surface raster. The term Raster 

denotes a means of describing a condition as a matrix of 

congruent rectangular cells. In the world of imagery, these 

cells are called pixels. In a continuous value raster the cell 

values are decimal values. Its possible also to have integer 

rasters and true-coloor imagery that represents reflected light 

in channels, like Red, Green and Blue and sometimes 

Infrared. I've just scratched the surface of raster data formats 

here. 

 

Explore Your Raster using ArcMap10.5 

 Use the Add Data button to add your national elevation 

dataset raster,image from the source folder. 

 Use the Identify Tool to click on a cell. Note the Pixel 

Value and the Strtech Value. 

 The Pixel Value represents the elevation of the cell that 

you clicked, in Meters above Mean Sea Level. The cell 

values in most cases were determined by interpolating 

points collected with stereo photogrammetry. 

 The Stretch value is a number between 0 and 255. The 

stretch can be manipulated with the symbology properties 

of the layer. Try different symbolization methods. 

 zoom to a scale and a location where you can clearly see 

the shape of a cell. Note that in a projected data frame, the 

cells are not square. You could use the measure tool to see 

their dimension. It is about 9 by 7 meters. With a 
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resolution like this you would not expect this 

representation of elevation to represent features in the 

landscape that are less then 30 meters in extent (a three-

by-three cell neighborhood.) Why not? 

 Take a look at the Source properties of the raster. Take a 

look at the spatial referencing system of the raster. It is 

GCS, NAD83. This means that the inherent units used to 

encode the location and the shape of cells is simply 

Decimal Degrees. This explains why the description of the 

Cell Size in the source properties is such a very small 

number -- because 9 meters is a very small portion of a 

decimal degree (approximately 100 kilometers at the 

equator.) Ths mismatch in scale between the X,Y units 

and the Z units (meters) wil lbe a problem we have to deal 

with later. 
 

Creating Shaded Relief 
We will begin by transforming our elevation raster to a 

shaded relief map and an aspect layer using wizards from the 

ArcGIS Geoprocessing Toolbox. You will see how to use 

the individual wizards in the toolbox. A the end of this 

document, you will see how geoprocessing tools can be 

chained together to create custom tools that will let us create 

custom wizards to automate useful tasks 

 

Transforming Elevation to Hillshade and Aspect;These 

two tasks will allow us to introduce the toolbox and a few 

simple wizards. The input raster for each of these procedures 

should be projected as described above. 
 

Hillshade with GCS: The hillshade tool shades slopes 

based on their steepness and direction. This reqires that the 

X, Y and Z (elevation) coordinnates are all in scale. If you 

create a hillshade on a raster whose XY coordinates are GCS 

(latitude and longitude) your Z values wil be drastically out 

of scale with X and Y and wil create an effect of an 

extremely steep, ragged jagged landscape. Your hillshade 

wil look like this screenshot. If your hillshjade looks like 

that, then you need to make sure you have set your 

geoprocessing environment. 

 

 
 

Create Hillshade and Aspect Rasters with ArcMap10.5 
1) Make sure you have the Spatial Analyst and 3d Analyst 

extensions enabled in Tools->Extensions 

2) Open the Toolbox Panel in ArcMap by clicking the little 

red toolbox icon raster. 

3) You can find the Hillshade and other surface tools in 

the Spatial Analyst toolbox within the Surface toolset. 

4) Open the Hillshade tool. 

5) Click the Show Help button at the bottom of this 

geoprocessing dialog. 

6) Click in any of the input boxes and note the context 

sensitive help. 

7) Click the More Help link at the bottom of the Help 

panel to see more information about the paremeters of 

this tool. You can also click More information about 

how Hillshade works" on this page to see a more 

conceptual discussion. 

8) In the Output Raster blank use the browse button to 

find a location in your project folder and give your 

output raster a name with a .img suffix. 

9) Proceed to create a hillshade raster. 

10) Take a look at the Display properties of the raster. See 

that its stretch type is set to Minimum Maximum. You 

can play with different stretch methods to see what they 

do. The object is to be able to integrate the hillshading 

into your map's background so that you can see it. 

 

Making Contours 

The next set of steps covers the creation of contours. The 

"Create Contours" tool in the surface toolbox makes it 

straightforward to choose a contour interval and to scale the 

vertical units using a Z-Factor. These contours can also be 

exported to CAD. The references and processing steps listed 

below cover the basic tools for creating contours. For a more 

nuanced approach, take a look at the DEM to DXF 

Contours tool described in the next section. 
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Create and Label Contours 
1) Find the Contour tool in the tool panel under Spatial 

Analyst Tools > Surface tool set. 

2) Open the help panel on the wizard, and mouse over the 

different fields. 

3) Click the Help button at the lower right to look at the 

entire help document. 

4) It may take some experimentation to choose a contour 

interval that reveals the lay of the land without greating 

inscruitable bunches of contours. 

5) If you want to change the Z units to feet, use a Z-Factor 

of 3.28. 

6) Once you have created a new contour featuree class, 

open the Attribute Table of your new contour layer. 

Note that each contour is a polyline and has an attribute 

named Contour that holds the elevation for each. 

7) You can label the contours with the label properties of 

the layer. Make sure that you choose the correct 

attribute to label your contours. 

8) It is conventional to associate contours with the line that 

they are labeling by making the labels a similar color as 

the line and aligning the label with the line. Alignment 

of labels is accomplished withthe Placement 

Properties options in the Label Properties dialog for 

your layer. 

9) To keep the contour label from conflicting with the line, 

you can alter the label properties to create a halo under 

each label. To find the halo mask properties, go to 

the Label Properties for your contour layer, 

choose Symbol, then Edit Symbol than set your options 

under the Mask tab. It is best to choose a color that is 

similar to the hue and value of the general background 

of your map. 

10) Finally, if you want to show a lot of contours, say every 

Meter, You can help your users by creating a layer 

of index contours, say every five meters. Your index 

contours can be darker and labeled while the one meter 

contours are not. 

 

 
                                

 
 

Reproject and Reformat your Elevation Model 
The terrain rasters from USGS are encoded using a plain 

Geographic Coordinate System GCS, which means that the 

X and Y units are decimal degress of Latitude and 

Longitude. The Z units are Meters above Sea Level. That 

means that a unit of X is over 100,000 times the earth 

distance as a unit of Y. GCS also means that unless you are 

oon ther equator the cells are substantially different from 

square. These coordinate system issues can make a 

difference when modeling certain relationships like Slope 

and Hillshading. When you need to get the X,Y, and Z units 

of your terrain model into sync, then you need to reproject it. 

 

About Resampling: When a raster dataset is projected from 

a plain geographic coordinate system to a projected one, the 

size and shape of the cells is transformed. You can think of 

Resampling as creating a new grid of cells and assigning 

values to the new cells based on the values of the old cells. 

The default method (Nearest Neighbor Resampling) simply 

assigns a value to the new cell based on the value of the cell 

in the old raster that is nearest to the center of the new one. 

This is the right thing to do with rasters whose values 

represent categories. For rasters that represent a continuous 

surface the Nearest Neighbor method can create stair-

stepped stryations. For continuous value rasters, like 

elevation models, the Cubic resampling method is best. 

 

Dem Extraction Matching with Orthoimage 

 

In this step, we set the DSM extraction properties, we check 

the advanced extraction properties and we generate and view 

the DSM from aerial image stereo pairs. In the end we check 

the Contour Map.The quality of DSM products are measured 

by how accurate the elevation is at each pixel and how 

accurately the morphology is presented. Several factors are 

important for the quality of DSM derived products: 

 Terrain roughness 

 Sampling density (elevation data collection method) 

 Grid resolution or pixel size 
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 Interpolation analysis 

 Vertical resolution 

 Terrain analysis  

 

In order to check the geometric accuracy of the obtained 

results, building heights and points on the ground have been 

measured manually. These measurements have been 

compared with the generated height models. We selected 

points in the center of the building tops and on the ground at 

a sufficient distance from the facades. The root mean square 

(RMS) difference between the manually measured heights 

and the automatic results turned out to be ±22 cm. In general 

it can thus be stated, that for the height accuracy is in the 

range of two pixels GSD. This value includes not only the 

matching accuracy, but also the accuracy of manual 

measurement 

 

 

 
 

 
 

 3D Modelling 

 Beginning a 3D Modeling Project in ArcGIS 

In an earlier construction on Degital Elevation Model, we 

got some experience with GIS data sources that represent the 

elevation of the terrain. This will take this a step further. We 

will look at a few additional types of data that let us 

represent the form of places in three dimensions, or at least 

two-and-a-half dimensions! 

 

We are going to start with a large city-wide repository of 

data representing terrain, buildings and the materiality of the 

ground. From this we will clip out a smaller dataset that we 

can play with in 3D without over-burdening a modest 

computer. Our clipped dataset is going to include: A Terrain 

Model, A Ground-Plan Image, Buildings, and a Clipping 

Frame. At the end of the tutorial we create a 3D model from 

these that we can play with and generate renderings from a 

tool called ArcScene. The 3D datasets that we extracr from 

GIS may also be exported to other tools, such as SketchUp, 

Google Earth, AutoCAD, Rinoceros, and others. 

 

 

 
 

Save a Georeferenced Groundplan Image 

As we have explained above, one element of our site model 

will be an image of the groundplan for our site and its 

context. This image will represent the roads, water, land and 

open spaces within the area covered by our clipping frame. 

The image will also include the outline of the frame. This 

wil make it very easy to register the image as with other 

layers as we export them to other tools. 

 

Before we get into exporting the images we should think 

about resolution. We don't want the images to have more 

resolution than we need, because this will create 

unnecessary problems in every thing we do subseqently. 

 

Export a Groundplan Image 
1) Zoom out to your context frame and measure its width in 

meters. 

2) For the context image, you don't necessarily need a very 

high-resolution image. A good resolution for your 

context image may be about a half-meter per pixel, which 

is good enough to see distinguish buildings, roads, cars, 

etc. 

3) Thinking about it another way, many programs like 

AutoCAD and Sketchup will choke if you try to drape a 

texture with more than, say 4000 x 3000 pixels... So if 

your context image is more than 4 kilometers wide, think 

about that. 

4) Arrange your map display to include the model clipping 

frame. 

5) Think about the sort of grapnhical hierarchy thou would 

want in a reference image that will be draped on an aerial 

photo in your model. You may want to use other overlays 

with transparency to colorize the photograph or to 

include details for some other GIS layer that you have. 
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6) Choose File>Export Map to export a jpeg image. You 

can use the options for the export jpg dialog to set the 

quality to about 95% which will substantially shrink the 

file size. 

7) In the Export Map Dialog, you should check the option 

to Save World File, which will save some 

georeferencing information for the image. 

8) Use Bookmarks > Create to save a bookmark for the 

current map extent 

 

 
 

Export a Clip of your Elevation Raster and Groundplan 

Image 

Our Elevation Raster from US Geological Survey uses 

Decimal Degrees of Latitude and Longituse as its 

geographic referencing system. This is problematic, since 

the Elevation units are in Meters. I've reprojected this raster 

to Massachusetts State Plane Mainland Meters. You will 

find this raster in the USGS group layer. Because we want to 

make a nice compact 3d model, we will export a clip of the 

elevation model using the same extent that we used to export 

the groundplan image. Note that if you want your terrain 

dataset clipped exactly to your model frame you can use the 

clip raster tool from the Data Management Tools > Raster 

> Raster Processing toolset. 
 

Clipping a Raster 
1) Return to the bookmark for your model extent if 

necessarry 

2) Right-click your digital elevation 

model, ned_third_sec_masp_mtr.img and choose Data 

> Export Data 
3) Make sure to change the option in the upper left to export 

the extent of the data frame. 

4) For Location choose your data folder. 

5) Save your clipped elevation model as a tiff or an Imagine 

Image format. 

 

Make a Clipped Shapefile of your Model's Buildings 

Finally, we will select and save the buildings that occur 

within our model study area. Then we have everything we 

need to make a nice compact 3d model of our site! Like 

above, there are a few ways of doing this. If you want your 

buildings clipped neatly to the edge of your frame use 

the Clip tool; from the Analysis/Overlay toolset. Or if you 

just want a quick and dirty selection, you can right-click the 

buildings layer and choose Data/Export Data and set all of 

the options appropriately to export the buildings within the 

current display. 

 

Export your Buildings to a New Shape File 
1) If necessary, return to the bookmark you saved for your 

model frame. 

2) Right-click your buildings layer and choose Data > 

Export Data 
3) Make sure that you change your export option to export 

the features within the view extent.Save your buildings 

as a shapefile in your data folder. 

 

 
 

Portraying Your Model in ArcScene 

ArcScene is very similar to ArcMap, except it has some 

additional features for visualizing and navigating data in 3D. 

The following notes will provide links to documentation that 

will provide necessary details about how to add your data, 

adjust the display properties and to navigate your model in 

3D. The following links may help to jog your memory after 

an in-class demonstration 

 

Set Up your ArcScene Model 

1) Start ArcScene. Ste your ArcScene Document Properties 

to Use relative Pathnames. 

2) Add your clipped DEM and your buildings and your 

groundplan. 

3) Fix it Symbology properties of your groundplan, 

setting Stretch to none as discussed above. 

4) Set the Base Heights property of your ground plan 

to Float on an Elevation Surface provided by your 

DEM. 

5) Set the Extrusion Property of your Buildings Layer to 

extrude each building to the height indicated by the 

field Abs_Ht_Mtr. 

6) Inspect the model to see if it makes sense 

 

Navigating in ArcScene and Saving a View 
Now that you have a 3D model you wil want to try flying 

around and saving some images that you can use to describe 

aspects of your site. Se the refeences below for hints on 

navigating in your ArcScene model 

 

Create a Birds-Eye View Image 
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1) Navigate your model until you find a view that shows 

what you want. 

2) Choose File > Export Scene > 2d to export an image of 

your model. 

3) Note that arcscene offers a special box for adjusting the 

resolution of your exported image in the View Size box 

at the bottom left corner of the export image dialog.  

 

 
Processing of 3D Model 

 

4. Result and Discussion 
 

3D Building 

 

Many GIS problems can only be solved in 3D, particularly 

in the area of urban development, with capabilities for 

generating high-quality 3D building using the same GIS 

data. 

 

Modeling objects for 3D descriptions of the real world have 

been useful for many urban applications such as planning, 

construction and representation of the urban sceneries. 

Buildings, roads, trees and terrain are considered as the most 

important objects in producing a 3D city model particularly 

for the creation of virtual environments. 3D city model is 

basically a computerized model or digital model of a city. 

This work considers important stages involved in creation of 

3D city models, which includes reconstruction of buildings, 

landscape and urban settings that are relevant in urban and 

environmental planning. The platform used in the creation of 

a virtual 3D city model has been provided by the GIS 

environment and assisted by ArcScene; a 3D modeling 

software. The emphasis is placed on the use of aerial and 

terrestrial photographic techniques and the existing 

topographical map data. 

 

In this work, to generate the 3D model, we followed several 

steps: 

 Geodatabase/2D Information. 

 3D Streets, Blocks, and Parcels (import or creation). 

 3D Extrusion, Roof Generation, and Street Furniture. 

 Texturing and Fac_ade Creation. 

 Finished 3D City and Updation in the Geodatabase. 

 

ArcScene software delivers a full suite of tools to aggregate 

geospatial data, layout and edit street networks, generate and 

modify buildings. The essential tasks performed are: 

 Turn the 2D feature into 3D based on an elevation surface. 

 Create 3D urban scenes based on standard GIS data. 

 Semi-automatic and manual extraction of 3D features 

 

 
 

Architectural aspect using 3d model 

The objects have building features were transformed into 

polygon features and line features were transformed into 

polyline features such as roads networks and other utilities 

layers. The 2D base model was created very accurate and 

detailed. The GIS Data Modeling is an important step to 

define all required geospatial databases, including vector and 

raster classes and their relationship classes based on the 

defined objectives of project.This will draft what is required 

and missing to build the required GIS data model 

 

3D-map database employed in the application is a database 

product distributed at the university. This database involves 

the characteristics. The geospatial data in the contemporary 

GIS are organized in one of many geo databases also called 

GIS or spatial databases. Commonly, geo database is an 

object-relational database designed to store, query, and 

manipulate geometry and coordinate data type as the other 

standard (attribute) database data types. The geometry and 

coordinate data type represents the shape and the location of 

an object in the physical world. 
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A simple prototype campus geo database was designed as a 

subset of the facility management data model. an example of 

common geo-database schema about main buildind 

container including spatial and attribute data in tables, 

feature classes, etc. and its relationships is given. The 

primary tables buildings ID and buildings name. The 

secondary tables are code classifiers of properties, rooms, 

room types, number and room ID. Then all spatial databases 

are joined to create layers in GIS environment in order to 

build the relational database and built the 3D model using 

the ArcScene from the ArcGIS software 

 

 

 

 

(AutoCAD files drawing added to deed of division for 

two types of buildings) 
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The next step was to build the 3D model into ArcScene after 

completing the 3D design of the university campus using 

ArcCatalog. A personal geo-database and a feature dataset 

were created.The layers such as buildings, roads, tree, etc. 

were added to a new ArcScene file. For using 3D model in 

ArcGIS, also the 3Dimension of the other buildings in the 

campus was created by using their number of floor and 3D 

symbols such as trees, cars were used to increase reality. 

Similar to 2D view, users can view different types of 

building’s campus planning information in the view (Fig. 

12), and the 3Dgreen space view. The various layers are 

displayed on the 3Dbuilding model using ArcScene. 

 

 
 

Extraction of Transportation Map From Given 3D 

Model 

 
 

5. Conclusion 
 

This paper investigates the necessity of detailed surface 

representation in order to generate a feasible platform for the 

detailed simulation of urban modeling. In this first step of 

the project, we generated a digital surface model based on 

aerial image stereo pairs using the matching 

method.Methods to generate the 3D city structures have 

been investigated and possible solutions are tested and 

discussed.Features and 3D models extracted from these data 

can provide benefits in various GIS applications, where the 

building is necessary. For example, 3D surface objects 

extracted from aerial photographs can represent a significant 

layer of GIS databases for the simulation of natural disasters, 

telecommunications planning (i.e., positioning of antennas). 

3D land use zoning allowed building volumes,usage, and 

density. They are the main tools defining the image of a city 

and brings into focus the model of best practice of the 

rehabilitation 

 

3D GIS provide urban designers and planners with a useful 

tool for modeling and analysis. The 3D GIS application was 

developed in order to evaluate urban space efficiently and to 

provide information about urban planning to local 

communities. This application enables users to visualize 

complicated urban planning information in the 3D way, to 

evaluate the allowable capacity of the block and to simulate 

building plans. With visualization and analysis capability, 

3D GIS is considered a powerful tool to solve various issues 

which modern cities confront. 
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